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1 はじめに 

本技術レポートでは XML 電文を用いたホワイトボード共有を考案するに至った経緯と考案した通信仕様を

紹介する。そのうえで、実装を行った結果明らかになった課題と現在の市場動向から今後のプロトコルの標

準化に向けた課題を整理する。また、付属資料としてプロトコルの詳細と電文例を記載する。 

 

2 参照文献 

本技術レポートで参照する文献を以下に示す。 

[MIME]        "IANA MIME Media Types XMPP://www.iana.org/assignments/media-type/",IANA 

[Q3402] "NGN UNI シグナリングプロファイル プロトコルセット 1 (NGN UNI Signalling Profile 

(Protocol Set 1))", TTC 標 準  JT-Q3402 第 2.0 版 , 情 報 通 信 技 術 委 員 会  (The 

Telecommunication Technologies Committee), 2011 年 5 月 

[RFC6120] "Extensible Messaging and Presence Protocol (XMPP): Core", RFC 6120, IETF, 2011 年 3 月 

[RFC6121] "Extensible Messaging and Presence Protocol (XMPP): Instant Messaging and Presence", RFC 

3921, IETF, 2011 年 3 月 
[RFC6122] "Extensible Messaging and Presence Protocol (XMPP): Address Format", RFC 6122, IETF, 2011

年 3 月 
[RFC3923] "End-to-End Signing and Object Encryption for the Extensible Messaging and Presence Protocol 

(XMPP)", RFC 3923, IETF, 2004 年 10 月 

[RFC4145] "セッション記述プロトコル（SDP）における TCP ベースのメディアトランスポート

(TCP-Based Media Transport in the Session Description Protocol (SDP))", TTC 標 準 

JF-IETF-RFC4145, 情報通信技術委員会 (The Telecommunication Technologies Committee), 

2007 年 3 月 

[SOAP] “SOAP Version 1.2 Part 1: Messaging Framework (Second Edition)”, W3C, April 2007 

“SOAP Version 1.2 Part 2: Adjuncts (Second Edition)”, W3C, April 2007 

[XML] "Extensible Markup Language(XML) 1.0 (Fifth Edition)", W3C, 2008 年 11 月 

[XML Namespaces] "Namespaces in XML 1.0 (Third Edition)", W3C, 2009 年 12 月 

[XML Schema] "XML Schema Part1:Structures Second Edition", W3C, 2004 年 10 月 

 "XML Schema Part1:Datatypes Second Edition", W3C, 2004 年 10 月 

[SVG] "Scalable Vector Graphics (SVG) 1.1 (Second Edition)", W3C, 2011 年 8 月 

[Base64] "The Base16, Base32, and Base64 Data Encodings", RFC 4648, 2006 年 10 月 

[RFC2397]    "The "data" URL scheme", RFC2397, 1998 年 8 月 

[RFC6455]    "The WebSocket Protocol", RFC6455, 2011 年 12 月 
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3 注意事項 

3.1 用語 

ホワイトボード : 特定の機器上でソフトウェアで実現される白いキャンパス。 

ホワイトボード共有 : １つのホワイトボードを複数機器で共有すること 

アウトチャネル : 電話番号等の ID を利用し、呼設定を行う通信 

インチャネル : アウトチャネルにて呼設定後、機器間でやりとりされる通信 

発呼  : 電話番号等の ID を使って呼設定の要求を開始すること 

着呼  : 呼設定の要求を受信すること 

発呼機器  : 本仕様で規定する通信手順を用いて呼設定の要求をする機器 

着呼機器  : 本仕様で規定する通信手順を用いて呼設定の要求を受信する機器 

描画機能  : 本仕様で規定する通信手順を用いてホワイトボードに描画する機能 

クライアント機能 : ホワイトボード共有を行うための要求を送信する機能 

サーバ機能 : ホワイトボード共有を行うための要求を受け付ける機能 

XMPP  : 機器間でメッセージ等の送受信を行うプロトコル 

XML  : 文書やデータの意味や構造を記述するためのマークアップ言語 

SVG  : XML をベースとした図形描画のための記述言語 

準正常系  : 規定通りの動作を行っても組み合わせによっては起こりうるケース 

異常系  : 利用上、特別なことを行った、または行われた結果起こる異常なケース 

 

3.2 本技術レポートの改版 

本編及び付属資料の内容が改版されたとき、本標準を改版する。改版によってプロトコルが変更される場合

は、A.1 項のプロトコルバーションを改版する。 

 

3.3 構文の記述 

本標準で記述する XML 文書は、BN 記法に従い記述する。 

各構文の記述内容は、2 項の各参考文献を参照のこと。 

 

3.4 ネームスペース 

本プロトコルで定義するネームスペースは 

 

XMPP ストリーム :  http://www.ttc.or.jp/mmsys/cs/stream/ 

SOAP アクション : http://www.ttc.or.jp/mmsys/cs/soap/ 

XML 変数  : http://www.ttc.or.jp/mmsys/cs/parameter/ 

error 規定  : http://www.ttc.or.jp/mmsys/cs/error/ 

 

とする。 
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4 本技術レポートの位置づけ 
4.1 従来のホワイトボード共有仕様と課題 

遠隔で資料を共有し円滑にコミュニケーションを行うための IP ベースの通信仕様は、H.323 を用いた T.126

（ホワイトボード共有）、T.127(ファイル転送)、T.128（アプリケーション共有）などが提案されており、TV

会議装置などに実装されていた。しかしながら、近年では NGN を始めとした SIP による IP ベースのマルチ

メディア通信が普及し始めているが、SIP を用いたホワイトボード共有はあまり普及していない。また、H.323

ベースのホワイトボード共有は ISDN など IP 網以外での動作も考慮し、ビット列による電文が規定されてい

たため、ビット列解析の実装が必要であり開発実装が困難であった。 

 

4.2 XML を用いた通信仕様の策定（XMPP・SVG・SOAP） 

IETF で議論されているインターネット利用に関するアプリケーションレベルのプロトコルの多くは、デー

タ圧縮よりも可読性や開発容易性を優先し、ビット列電文ではなくテキストベースの電文で仕様規定が行わ

れている。SIP を志向した仕様検討にあたっては、IETF に親和性のある仕様としてテキストベースの電文を

利用したホワイトボード共有仕様の規定が適当である。 

本レポートではテキストベースの電文の一例として XML に着目しプロトコル設計を行うこととした。

XML は、構造化されたデータをテキストベースで記述するためのマークアップ言語であり、XML を用いた

様々な通信仕様がインターネット関連技術として考案され普及しつつある。 

そこでまず、通信を行うためのセッション管理を行う方式として XMPP に採用した。XMPP はリアルタイ

ム双方向通を行うための電文規定で、文字チャット用の仕様として普及しているとともに様々な拡張性も考

慮されており、資料共有を実現するための電文を載せることが可能である。 

 次に、具体的にホワイトボードの描画情報の記述には SVG を用いることとした。SVG はベクタ情報とし

て描画情報を記載する方式であり、拡大によって描画が荒くなることがないという特徴も持つ。これにより

様々な画面サイズの端末間であっても滑らかな描画を行うことが可能になる。 

 さらに、描画情報以外にホワイトボード共有を実現に必要な能力交換やファイル送付などの制御を行う方

式として SOAP を採用した。SOAP は WEB サービス等で利用されている RPC プロトコルである。 

通信仕様の概要に関しては 5 章・6 章で述べ、プロトコル詳細・電文例は付属資料に記載する。 

 

4.3 仕様の動作確認と市場動向に合わせた再検討の必要性 

仕様策定後、XMPP を用いたホワイトボード機能を複数のシステム上で実装を行った。その結果、基本動作

は確認できたものの幾つかの課題が明らかになった。 

さらに、最近では端末の高機能化に伴い WEB ブラウザ搭載が増えてきており、今後の仕様改定に当たって

は最新の WEB ブラウザの機能を活用したホワイトボード共有機能の仕様も検討する必要性が高まっている。 

 課題の詳細に関しては 7 章で述べることとする。 
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5 プロトコル構成と条件 

5.1 プロトコル構成 

プロトコル構成は OSI 参照モデルに即した階層構造とする。 

本仕様ではアウトチャネルで成立した TCP のインチャネル上で，SOAP,SVG/XMPP を利用することにより

ホワイトボード共有を実現する。本プロトコルはインチャネルのプロトコル規定である。 

アウトチャネルに関しては JT-Q.3402[Q3402] に規定される SIP/SDP によるセッション確立や、

RFC6455[RFC6455]に規定される WebSocket を利用した通信線を利用した通信路の確立などが考えられる。 

 

表 5-1／TR-1045 プロトコル構成 

レイヤ 

使用プロトコル 

アウトチャネル 

(規定外) 

インチャネル 

7 アプリケーション 

SIP,SDP / WebSocket 

  等  

SOAP,SVG 

XMPP 6 プレゼンテーション 

5 セッション 

4 トランスポート UDP /   TCP  等 TCP 

3 ネットワーク IPv4/IPv6 

2 データリンク Ethernet 等 

1 物理 

 

5.2 プロトコル使用時の条件 

5.2.1 TCP 

XMPP パケットの転送に関して、トランスポート層のプロトコルとして JF-IETF-RFC4145[RFC4145]に従い

TCP を利用する。 

 

5.2.2 XMPP 

SVG 及びテキストメッセージ、SOAP の送信に利用する。 

XMPP1.0[XML]に準拠する。 

 

5.2.3 SOAP 

能力交換及びコンテンツ共有に利用する。 

SOAP1.2[SOAP]に準拠する。 

 

5.2.4 SVG 

ホワイトボード共有に利用する。 

SVG1.1[SVG]に準拠する。 
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5.2.5 インチャネルのプロトコル構造 

SVG1.1[SVG]及び SOAP1.2[SOAP]に従い、SVG メッセージ及びテキストメッセージの伝送に XMPP の

<message>スタンザを利用し、SOAP メッセージの伝送に XMPP の<iq>スタンザを利用する。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図 5-1／TR-1045 本プロトコルのイメージ図 

SOAP 

バイナリ送信 

SVG 

テキスト情報共有 

<iq> 

 

  
XMPP 

<message> 

TCP 
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6 プロトコルの動作概要 
6.1 ホワイトボードの共有モード 

本仕様では、下層のコンテンツレイヤに、上層の手書きレイヤを重畳させた 2 層構造によってホワイトボー

ドの共有画面を構成する。 

 コンテンツレイヤには通信を行う前に予め用意されたベースとなるドキュメント・画像・WEB ページ・

TV 電話画像などを共有する。コンテンツレイヤのコンテンツの編集は行わず、必要に応じてコンテンツの

差し替えのみを行う。一方、手書きレイヤは通信中に行われる情報で手書きを基本として、タッチ情報、チ

ャットなどのテキスト情報などを双方向でやり取りし、コンテンツを随時更新していく。 

 

 

 

 

 

 

 

 

 

 

 

 

図 6-1／TR-1045 本仕様におけるレイヤ構造 

 

 

本仕様ではコンテンツレイヤ・手書きレイヤの利用・未使用のバリエーション等によって、ホワイトボード

モード、マーカモード、タッチ選択モード、ファイル共有モードの 4 つの描画モードを規定する。 

描画モードは共有開始時のアクションのパラメータ設定によって切替える。 

 

表 6-1／TR-1045 ホワイトボード共有モードの説明 

 
手書きレイヤ（上層） 

あり なし 

コンテンツレイヤ 

（下層） 

あり 
・マーカモード 

・タッチ選択モード 

・ファイル共有モード 

 

なし ・ホワイトボードモード ※ 

※ファイル送信のみのアクション規定はあり    

 

 

 

 

 

 

  

  

  

手書きレイヤ（上層） 

コンテンツレイヤ（下層） 

端末に表示されるイメージ 

重畳 
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6.1.1 ホワイトボードモード 

手書きレイヤ（上層）に書いているもののみを共有するモードである。 

6.2 章で述べるコンテンツ共有フェーズは省略される。 

 

 

 

 

 

 

 

6.1.2 マーカモード 

コンテンツレイヤ（下層）にあるコンテンツの上の手書きレイヤ（上層）に描画を書き加えるモードである。 

 

 

 

 

 

 

6.1.3 タッチ選択モード 

コンテンツレイヤ（下層）にあるコンテンツのボタン等をユーザがタッチ操作するモードである。 

手書きレイヤ（上層）では、システムによる描画の付加は可能であるが、ユーザによる描画は 

抑止され書き加えることができない。 

 

 

 

 

 

 

 

6.1.4 ファイル共有モード 

コンテンツのみを共有し、コンテンツレイヤ（下層）にてプレビュを行うモードである。 

6.2 章で述べるテキスト及び手書情報共有フェーズは省略される。 

 

 

 

 

 

 

 

 

 

 

 

 
 

JPEG 画像 

 
 

 
予約 

確認 

JPEG 画像 
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6.2 ホワイトボード共有の各通信フェーズ 

本仕様において想定するホワイトボード共有の各通信フェーズを図 6.2 に示す。 

コンテンツの変更、共有モードの変更・端末能力の変更時は所定のフェーズに遡り、呼や TCP セッション

を切断せずに通信フェーズを継続することができる。以降、各フェーズについて述べる。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 6-2／TR-1045 ホワイトボード共有の各通信フェーズ 
 
 
 

発呼側 着呼側 

コンテンツ共有フェーズ 

テキスト及び手書情報共有フェーズ 

共有終了フェーズ 

アウトチャネル 

TCP セッション切断フェーズ 

呼切断フェーズ 

呼設定フェーズ 

TCP セッション確立フェーズ 

共有開始フェーズ 

能力交換フェーズ 

共有モード指定フェーズ 

インチャネル 

アウトチャネル 

共
有
モ
ー
ド
の
変
更 

端
末
能
力
の
変
更 

本仕様の規定部分 

コ
ン
テ
ン
ツ
の
変
更 
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6.2.1 呼設定フェーズ 

本フェーズは、インチャネルでのホワイトボード共有を実施するに先立ち、呼を確立することを目的とする。 

 

6.2.2 TCP セッション確立フェーズ 

本フェーズは、ホワイトボード共有に先立ち、TCP セッションを確立することを目的とする。本プロトコル

では、着呼側から SIP/SDP 等によって通知された待ち受けポートに対して、発呼側から TCP セッションを

張るものとする。 

 

6.2.3 共有開始フェーズ 

本フェーズは、呼設定後、発呼機器が着呼機器に対し、ホワイトボード共有の開始を要求することを目的と

する。 

 

6.2.4 能力交換フェーズ 

本フェーズは、発呼機器と着呼機器間において共有するホワイトボードの描画サイズおよびホワイトボード

共有プロトコルのバージョン、端末種別等の情報を交換することを目的とする。 

 

6.2.5 共有モード指定フェーズ 

本フェーズは、発呼機器・着呼機器に双方から、ホワイトボード共有モードを指定することを目的とする。

各共有モードの詳細は 6.1 章を参照のこと。 

 

6.2.6 コンテンツ共有フェーズ 

本フェーズは、発呼機器・着呼機器双方から、コンテンツの情報を送信することを目的とする。なお、起動

した共有モードによってはこのフェーズは省略されることがある。 

 

6.2.7 テキスト及び手書情報共有フェーズ 

本フェーズは、発呼機器と着呼機器間において共有する描画情報を相手機器に送信し、描画情報を受信した

機器は、描画情報をホワイトボードに反映させることを目的とする。なお、起動した共有モードによっては

このフェーズは省略されることがある。 

 

6.2.8 共有終了フェーズ 

本フェーズは、発呼機器または着呼機器において利用者からホワイトボード共有終了の指示を受けた場合、

もしくは呼切断の指示を受けた場合には、本仕様書に従うホワイトボード共有の終了を通知することを目的

とする。 

 

6.2.9 TCP セッション切断フェーズ 

本フェーズは、共有終了フェーズ終了後、TCP セッションを切断することを目的とする。 

TCP セッション切断は、TCP セッションを張ったクライアントとして動作している機器から TCP セッショ

ンの切断を行うものとする。サーバとして動作している機器からは行わないものとする。 

 

6.2.10 呼切断フェーズ 

本フェーズは、インチャネルでのホワイトボード共有終了後、呼を切断することを目的とする。  
 

－ 15 － ＴＲ－１０４５ 

 



 

6.3 動作シーケンス例 

本仕様書で規定するホワイトボード共有を実現するためのシーケンス例をアウトチャネル・インチャネルに

分けて示す。なお、アウトチャネルのシーケンスに関しては 5.1 章に述べたとおり仕様規定の範囲外である。 

 

6.3.1 アウトチャネルのシーケンス例 

アウトチャネルで動作させる例として SIP と WebSocket を用いた 2 つのシーケンス例を示す。 

SIP を用いたシーケンスは、NGN のような IP 電話網を用いる際のアウトチャネル実装例である。 

一方、WebSocket を用いた例は、インターネット上の WEB サービスとしてホワイトボード用のインチャネ

ル通信を利用するための実装例となっている。 

 

 SIP を用いたアウトチャネル通信の例 

SIP を用いた通信の例として、既に音声電話などの通信が確立している場合にホワイトボード共有を開始す

るためのシーケンスを下記に示す。本シーケンス例では、発呼機器、着呼機器両者に SIP 通信機能を搭載し

ホワイトボードのための通信を確立する必要がある。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※発呼機器からの切断する例を記載 

図 6-3／TR-1045 SIP を用いたアウトチャネル通信の例 

 

 

 

 

 

 

 

 

発呼機器 SIP サーバ 着呼機器 

SIP メディア追加要求 
<UPDATE>  with m=application 

SIP 応答<200 OK> 
with m=application 

SIP 応答<200 OK> 
with m=application 

インチャネル通信 

SIP 切断<BYE> SIP 切断<BYE> 

SIP 切断確認<200 OK> SIP 切断確認<200 OK> 

メディア（音声、映像、データ等）通信確立中 

SIP メディア追加要求 
<UPDATE>  with m=application 

SIP 確認<ACK> SIP 確認<ACK> 

追加操作 

通信終了 
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 WEBSokcet を用いたアウトチャネル通信の例 

WEBSocket を用いた通信の例として、WEB ページアクセスを用いた通信シーケンスを下記に示す。下記の

例では、通信確立前に予め WEB サーバにアクセスし（登録要求）、WebSocket を利用したアウトチャネルの

通信方法に関して情報を得た上で（登録応答要求）、その方式を元にインチャネルの通信を開始している。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※発呼機器からの切断する例を記載 

図 6-4／TR-1045 WebSocket を用いたアウトチャネル通信の例 

 

 

 

 

 

 

発呼機器 WEB サーバ 着呼機器 

WEBSocket 接続確立 
接続 

操作 

通信終了 

インチャネル通信 

WEBSocket 接続確立 

登録要求<HTTP  GET> 登録要求<HTTP  GET> 
 
登録要求応答 
<HTTP 200OK> 

登録要求応答 
<HTTP 200OK> 

WEBSocket 切断 
WEBSocket 切断 

共有開始要求<WebSocket> 
共有開始要求<WebSocket> 

開始要求応答<WebSocket> 
開始要求応答<WebSocket> 
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6.3.2 インチャネルにおける接続形態のシーケンス例 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 6-5／TR-1045  発呼機器からのホワイトボード共有のシーケンス図 

 

 

SIP サーバ 着呼機器 

TCP セッション確立フェーズ 

共有開始フェーズ 
F1 接続確立要求 
F2 接続確立応答 

能力交換フェーズ 

TCP セッション切断フェーズ 

F5 描画領域要求 

F6 描画領域応答 

発呼機器 

共有モード指定フェーズ 

共有終了フェーズ 

F7 描画開始要求 

F3 初期プレゼンス通知 
F4 初期プレゼンス通知 

F8 描画開始応答 

F21 接続終了要求 

F22 接続終了応答 

コンテンツ共有フェーズ 

F11 ストリーム開始要求 
F12 ストリーム開始応答 
F13 データ転送通知<data> 
F14 データ転送応答 

F15 ストリーム終了要求 
F16 ストリーム終了応答 

テキスト及び手書情報の共有フェーズ 
F17 テキスト情報通知 

F18 テキスト情報通知 

F19 手書きレイヤ情報通知 

F20 手書きレイヤ情報通知 

F9 コンテンツの共有要求 
F10 コンテンツの共有応答 
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7 今後に向けた考慮すべき点 

 

本章では、本編に則って実装することによって見つかった今後考慮すべき点、およびより多くの人に本技術

レポートに則った機器を使用していただくために考慮すべき点をまとめる。 

 

7.1 実装によって見つかった考慮点 

7.1.1 XML/XMPP 利用の課題 

 図 7-1 の電文例に示す通り XMPP では XML 電文の一部を随時送信することで電文を送信し、最終的に

通信が終了する際に初めて XMPP を終了させる電文が送信され XML として完成する。 

そのため、通信が終了するまでは XML が完結していないために、XML パーサーの作りによっては通信途

中の電文を読み込ませるとエラーが発生してしまう場合がある。これにより XMPP を用いた場合、一般の

XML ツールを活用することが難しいという課題が明らかになった【課題①】。さらに、途中で XML パーサ

ーを通しているが、XML の規定に反している可能性がある。 

また、本仕様では XML がベースとなる XMPP 内に、さらに XML ベースの SOAP アクションを乗せたた

め、2 重構造になる箇所が発生しやすくなり、特に SOAP アクション内で XML 文書としてエスケープ記述

を行う必要がある箇所が多くなったという課題も発生している。【課題②】 

図 7-1／TR-1045 XMPP の電文構造における課題 

<?xml version='1.0' encoding='UTF-8'?> 
 <stream:stream xmlns='ngn:EasyInfoSharing‘ 
                            xmlns:stream=‘http://www.ttc.or.jp/mmsys/cs/stream/’> 
 

（中略） 
 
<iq type='set' id='1'> 
 <env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
 <SetMode> 
   <mode>WhiteBoard</mode> 
 <InitialBackGround> 
     <?xml version='1.0' encoding='UTF-8‘ ?>  
   <BackGroundInfo 
          xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 
        <BackGroundColor>white</BackGroundColor> 
       <SharedContent> 
       <sid>ch3d9s71</sid> 
           <ContentName>test.jpg</ContentName> 
           <Format>image/jpg</Format> 
       <Size>123514</Size>  
   </SharedContent> 
     <SharedRegion> 
        <x>0</x> 
            <y>0</y> 
            <Width>300</Width> 
            <height>200</height> 
   </SharedRegion> 
   </BackGroundInfo> 
<InitialBackground> 
</SetMode> 
</env:Body> 
</env:Envelope>  
</iq> 
 

（中略） 
 
</stream:stream> 

【課題②】 

 エスケープ

が必要 

【課題①】 

アクション単位毎に 

随時送信 

終了時に初めて 

XML として完結 
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これらの課題を解決するための方法として、XMPP の代わりに JSON 形式のメッセージ利用が考えられる。

JSON は JavaScript におけるオブジェクトの表記法をベースとした軽量なデータ記述言語であり、Javascript

はもちろん、C,C++,C#,Java,Perl,Python など様々なプログラミング言語で XML のようなパーサーが用意され

ており、書き出し／読み込みが容易に行うことができる。本仕様を JSON 形式に変更した例を図 7-2 に示す。 

 
{ 
    "action": "SetMode",  
    "mode": "WhiteBoard", 
    "BackGroundInfo": { 
        "BackGroundColor": "White",  
        "SharedContent": { 
            "ContentName": "test.jpg",  
            "Format": "image/jpg",  
            "Size": 123514,  
            "sid": "ch3d9s71" 
        },  
        "SharedRegion": { 
            "height": 200,  
            "width": 300,  
            "x": 0,  
            "y": 0 
        } 
    } 
} 

ホワイトボードモードを動作させる際の電文例[図 7.1 のアクション抜粋] 
 

{ 
    "action": "svg",  
    "polyline": { 
        "points": [ 
            "100,200",  
            "131,250",  
            "168,305" 
        ],  
        "stroke": "black",  
        "stroke-width": 10 
    } 
} 

 
{ 
    "action": "ShareContent",  
    "type": "WEB", 
    "SharedContent": { 
        "URL": "http://goo.ne.jp" 
    },  
    "SharedRegion": { 
        "height": 300,  
        "width": 200,  
        "x": 0,  
        "y": 0 
    }  
} 

 
上位レイヤ（手書き）の JSON 電文例 下位レイヤ（コンテンツ）の電文例 

図 7-2／TR-1045 JSON 形式を用いた電文例 

JSON 形式の電文は XMPP とは違い一つのデータ郡で電文を完結させることができ、パーサーにかけやす

い【課題①の解決】。また、図 7-1 の XMPP の場合はエスケープ表記以外にも XML 規定に沿うために、

<BackGroundinfo>タグなどが必要であったが、図 7-2 に示した JSON 形式の場合には不要であり、より簡潔

に変数を表記できることがわかる。【課題②の解決】 

 

ただし、JSON を利用した場合も XMPP を用いた電文と同様、文字ベースの電文送信になっているため、

バイナリファイルの送受信方法については base64 などを用いてバイナリを文字コードに変換する必要が出

てくる。その際には、直接バイナリの送信に比べてファイル容量が大きくなってしまうため、ファイルサイ

ズが大きくなると、ホワイトボード共有の動作性能に影響与える可能性がある。 

この点に関しては今後ユースケースを詳細化していき、文字コードに変換する方式が不適切である場合に

は、JJ-40.20 のインチャネルを用いた通信路を形成し、バイナリを送信するなどの仕様などが検討する必要

がある。 
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7.1.2 異なる端末間で共有画面を形成する際の考慮点 

 本仕様においては、共有する画面領域を自由に設定することを可能とし、2 端末間で最低サイズを算出す

ることで柔軟な資料共有を行えるように規定を行った。しかしながら、実際にはネゴシエーションした画面

領域は 2 端末間の座標系を合わせるためにしか利用されず、ユーザビリティの観点から実際の描画サイズは

共有の拡縮によって調整されるため，電文上のサイズと描画サイズの認識違いが起こりやすく煩雑であった． 

 

 

 

 

 

 

 

 

 

 

 

 

図 7-3／TR-1045 描画サイズのイメージ 

 

そのため、共有画面サイズのネゴシエーションに関しては、論理サイズバリエーションを予め決めておき、

各端末が必要に応じて、拡縮を行いながら描画を行う規定を行う方式であれば混乱が少なくなると思われる。 

また、拡縮だけでは対応しきれない縦横比のネゴシエーションに関しても、一般的な端末なら画面の縦横

比は 16：9 や 4：3 などある程度のバリエーションが決まっているため、バリエーションを予め設定する方

法をとることが可能であると考えられる。 

 

 また別の課題として、共有するコンテンツとして WEB ページ共有を URL の引き渡しで行う方式を利用し

た際、端末が異なると表示画面の同一性は担保できないという課題が存在する。 

利用機器によって、ブラウザが異なる可能性があり WEB ページの表示に違いが出るとともに、近年では

端末の種別や解像度によって動的に表示内容を切替える WEB ページも存在するため、異種端末間では同様

の画面イメージを共有することがさらに難しくなっている。  

 そこで今後、資料共有仕様のユースケースの詳細化において，同一の WEB ページを共有する必要性が明

らかになった場合にはどちらか一方の WEB ページを画面として共有する方式などの検討が必要となる。 

 

7.1.3 SVG を利用したテキスト表示の課題 

 SVG は図形や絵を描くための画像形式である。そのため、SVG 内に存在するテキスト表示は図形の一部

としてのテキストという位置づけであるため、その位置配置に関しては図形の配置と同様にユーザが逐一バ

ランスを考慮して配置する必要があり煩雑で有るということがわかった。 

一方、HTML では文章構造を定義してタグを用いて表記することによって自動でレイアウトが行われる。

さらに、CSS を読み込むことでそのレイアウトのカスタマイズも比較的簡単に行うことができる。 

そこで、文字によるコンテンツを送信する方式として SVG による電文送信に加えて、HTML の一部を送

信し Javascript の innnerHtml などを用いて随時更新を行うなどの仕様を検討する必要がある。 

 

 

 

 

 

電文上のサイズ 
800x600 

 

端末 B の実描画サイズ 
400x300 ［縮小］ 

 

端末 A の実描画サイズ 
960x720 ［拡大］ 

端末 B 端末 A 
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7.2 より多くの人に本技術レポートに則った機器を使用していただくために考慮すべき点 

7.2.1 インターネット通信技術の活用 

本仕様では NGN での利用を考慮したため、インチャネル仕様として TCP 通信路の中で XMPP を用い通信ス

トリームを管理することでホワイトボードの制御を行う仕様を提案している。しかしながら、近年では持続

的通信を実現するWebsocketやポーリングによる通信を実現するAjaxを利用する機能が新たに登場している。

この機能を用いることで、本仕様で行っていた XMPP の通信状態の監視は比較的簡単に行うことができ、 

さらに 7.1.1 で述べた課題も解決できる可能性が有る。 

そのため今後、これらの持続的接続機能を活用することも検討していく必要が有ると思われる。 

 

7.2.2 標準ブラウザ活用のための仕様検討 

 利用対象機器が多様化しており、それぞれの端末に対して今回提案した仕様を搭載することは難しい。ま

た、近年では HTML5 などのブラウザ技術の標準化によって、7.2.1 に述べたような Websocket 機能など様々

な機能がブラウザに搭載されつつある。そこで、どの端末にも搭載されていて高機能化しつつあるブラウザ

を活用した方式検討を行っていく必要がある。例えば、6.3.1 に記載したシーケンス例において、初回の WEB

アクセスの応答時にアウトチャネルの通信方法だけではなく GUI も含めたホワイトボード機能に関する動

作を取得し、新たなアプリを作成せずブラウザだけでホワイトボードが利用できる環境が整えられる可能性

がある。 

 

7.2.3 クラウドサービスとの連携を考慮 

 今回提案した仕様では 2 端末間の P2P 接続によってホワイトボードを実現した。しかしながら、ビジネス

場面において遠隔会議で利用するなどの場合には、1 対 1 ではなく複数拠点に対してホワイトボードの共有

が必要となる可能性がある。その際にはクラウドサービス経由する構成を用いることによって、複数人に対

して描画の電文を送付するとともに、描画の権限操作などの機能など新たな機能を追加するなど、P2P では

実現することが難しい新たなサービスに関しても提供を検討していく必要がある。 

 

8 おわりに 
 本レポートでは XMPP・SOAP・SVG を用いた２端末間のホワイトボード共有におけるインチャネル仕様

を提案した。この仕様を用いれば、アウトチャネルが NGN である場合に加えてインターネットであっても、

インチャネルは共通的な仕様を利用しホワイトボード共有を行うことが可能となる。 

その一方、今回採用した XMPP/SOAP を用いた通信の課題点や端末実装上の課題点も明らかになった。 

ユースケースによっては今回の仕様で採用した方式以外の通信仕様が適切である可能性も示唆した。またそ

の一例として近年様々登場しているインターネット技術を活用が考えられる。今後、本仕様を発展させてい

くためには、ユースケースの詳細化に加えてインターネット技術動向を注視し、それらを活用した方式の再

検討が必要である。 
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付属資料A ホワイトボード共有プロトコルの詳細 

本仕様書で規定するインチャネルのホワイトボード共有プロトコルは、発呼機器から着呼機器に対するリク

エストと、着呼機器から発呼機器に対するレスポンスからなる。これらのリクエストとレスポンスは能力交

換及びコンテンツ共有に利用する SOAP メッセージと手書情報の共有に利用する SVG メッセージ、テキス

ト情報の共有に利用する TEXT メッセージからなり、伝送プロトコルとして XMPP プロトコルを利用する。 

 

A.1 バージョンの表記 

本プロトコルのバージョンを ExchangeCapability の"version" タグと"AgentName" タグに記載する。記載内容

は表 A-1 の 2 種別とする。バージョンが改版された場合は下位互換を確保する。 

 

表 A-1／TR-1045 記載するバージョンの種別 

種別 内容 

プロトコル種別 
本プロトコルのバージョンを表す 

バージョンが改版された場合は下位互換を確保する 

機器種別 
本プロトコルを実装したベンダ名称、機器（アプリケーション含む）の名

称とバージョンを表す 

 

表 A-2／TR-1045 設定する内容 

種別 項目 設定内容 

プロトコル種別 プロトコルバージョン "1.0"を設定する 

機器種別 

ベンダ名称 自由設定とする 

機器名称 

（アプリケーション名） 

自由設定とする 

機器バージョン 

（アプリケーションバージョン） 

自由設定とする 

※複数表記は行わないこと 

 

A.2 バージョンの扱い方 

A.2.1 プロトコル識別 

プロトコル種別のバージョンが改版された場合は下位互換を確保する。 

ExchangeCapabilityとExchangeCapabilityResponseの"Version" タグに記載されているプロトコル識別のプロト

コルバージョンが異なる場合は、下位バージョンで動作する。 

 

A.2.2 機器識別 

機器識別は、本プロトコルを実装したベンダ名称及び機器名称を自由に設定することができる。 

ExchangeCapabilit と ExchangeCapabilityResponse の"AgentName" タグに記載されているベンダ名称及び機器

名称を同じと見なした場合は、発呼機器と受信機器で利用できる SOAPアクションを独自に定義してもよい。 

ベンダ名称及び機器名称が異なる場合は、独自に定義した SOAP アクション及び SVG 電文は無視し、本プ

ロトコルで規定する動作を行う。 
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A.3 XMPP 

XMPP 1.0 に準拠する。 

ネームスペースには「ttc:EasyInfoSharing」を利用する。(「’jabber:client’」は利用しない) 

各スタンザ(message, iq, presence)には、from 属性および to 属性は記載しない。 

構文エラーを検知した場合、iq スタンザでは type に「error」を設定し、他のスタンザでは無視すること。 

上記以外については、XMPP1.0 に準拠すること。 

 

A.4 SOAP 

SOAP1.2 に準拠する。 

SOAP メッセージ内で使用できる文字のエンコーディングは UTF-8 とする。 

 

表 A-3／TR-1045 レスポンスの SOAP メッセージ 

設定内容 備考 

<?xml version="1.0" encoding=”UTF-8” ?>  

<env:Envelope 

xmlns:env="http://www.w3.org/2003/05/soap-envelope"   

xmlns=" http://www.ttc.or.jp/mmsys/cs/soap/"> 

 

 <env:Body>  

  <request-method-name 

env:encodingStyle="http://www.w3.org/2003/05/soap-encoding" 

xmlns=" http://www.ttc.or.jp/mmsys/cs/soap/"> 

request-method-name の部分に

リクエストメソッド名を設定

する 

  <（引数）>  

 

A.5 SVG 

SVG1.1 に準拠する。ただし、本仕様においてはその一部のタグのみをサポート必須としている。サポート

すべきタグの種別・属性値の詳細に関しては B.2.15 を参照のこと。 
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付属資料B SOAP,SVG/XMPP メッセージの規定 

B.1 注意事項 

B.1.1 変数の M/O の扱い 

各メッセージの変数には「M/O」が規定されており、「M」は Mandatory の略であり必須、「O」は Option の

略でありオプションである。 

オプションが設定されたアクションを受信した場合、受信した機器で解釈できるオプションである場合は、

受信した機器はオプションに設定された内容で動作させ、解釈できなければ、無視する。 

 

B.1.2 XML のタグによる変数の記述 

電文表においてタグを付けて表記した変数に関しては、変数を XML タグで表記し値を記述すること。 

また、もし XML のタグ内に記述すべき値が存在しない場合には、「M/O」によって以下の表記を行うこと。 

「M」の必須タグは、そのタグの値が無い場合であっても、値の無いタグ（空タグ）を記載する。 

「O」のオプションタグは、そのタグの値が無い場合は、SOAP メッセージには記載を省略しても構わない。 

 

B.1.3 XML の属性値による変数の記述 

電文表においてタグを付けずに表記した電文に関しては XML のタグではなく上位の XML タグの属性値と

して値を表記しなければならない。以下の電文は、属性値による表記が必要である。 

① XMPP の<iq>スタンザに付属する「id」「type」変数 

② B.2.18 節に記載した図形描画の詳細パラメータに関する変数群 

また、「M」の必須の属性値に関しては値の入力は必須である。また、「O」「C」で値が存在しない場合は属

性値として記載してはならない。 

 

B.1.4 SOAP アクションの独自拡張 

描画領域要求（ExchangeCapability）と描画領域応答（ExchangeCapabilityResponse）の"AgentName" タグに記

載されているベンダ名及び端末名が同じであることを前提に、送信機器と受信機器間で利用できる SOAP ア

クションを独自に定義してもよい。独自に定義する SOAP メッセージの先頭には「x-」または「X-」を記述

すること。 

不明な SOAP アクションを受信した場合、エラーを返すこと。エラーの詳細に関しては B.4 を参照のこと。 

 

B.1.5 タグの独自拡張 

本プロトコルで規定している SOAP アクションには、変数（タグ）に "Private" タグを設けている。 

描画領域要求（ExchangeCapability）と描画領域応答（ExchangeCapabilityResponse）の"AgentName" タグに記

載されているベンダ名及び端末名が同じであることを前提に、この "Private" タグの子要素に、送信機器と

受信機器間で利用できる変数（タグ）を独自に定義してもよい。独自に定義する変数（タグ）名の先頭に「x-」

または「X-」を記述すること。 

不明なタグを受信した場合、無視すること。 
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B.2 メッセージ 

B.2.1 接続確立要求 

ホワイトボード共有の開始において、発呼機器が着呼機器に対して、ストリームの開始を要求するために用

いる。 

 

<?xml version='1.0' encoding='UTF-8'?> 

<stream:stream xmlns=’ttc:EasyInfoSharing’ 

             xmlns:stream=‘http://www.ttc.or.jp/mmsys/cs/stream/’> 

図 B-1／TR-1045 接続確立要求 

 

B.2.2 接続確立応答 

接続確立要求を受信した着呼機器は、接続確立要求の構文が正しく、ホワイトボード共有が開始可能である

場合、発呼機器に対して接続確立応答を送信するために用いる。 

 

<?xml version='1.0' encoding='UTF-8'?> 

<stream:stream xmlns=’ttc:EasyInfoSharing’ 

       xmlns:stream=‘http://www.ttc.or.jp/mmsys/cs/stream/’> 

図 B-2／TR-1045 接続確立応答 

 

B.2.3 初期プレゼンス通知 

発呼機器は接続確立応答の受信後、初期プレゼンス情報を着呼機器に送信するために用いる。また、着呼機

器は発呼機器からの初期プレゼンス情報の受信後、初期プレゼンス情報を発呼機器に送信するために用いる。 

 

<presence type='available' /> 

図 B-3／TR-1045 初期プレゼンス通知 
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B.2.4 描画領域要求（ExchangeCapability） 

発呼機器は着呼機器に対して、プロトコルバージョン及び機器種別（ベンダ名、機器名（アプリケーション

名）、機器バージョン（アプリケーションバージョン））、サポートする描画モード及び描画能力を通知する

ために用いる。 

 

表 B-1／TR-1045 描画領域要求（ExchangeCapability） 

スタンザ/変数 M/O 内容 

<iq> M － 

 type   (<iq>の属性値) M ・set を記載する 

 id     (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を

設定する 

<env:Body> M － 

 <ExchangeCapability> M － 

  <Version> M  ・プロトコルバージョンを半角数字及びピリオドで 

記載する 

・複数記載する場合は連続してカンマで区切って記載

する 

  <AgentName> M ・機器種別（ベンダ名,機器名（アプリケーション名）,

機器バージョン（アプリケーションバージョン））を

半角英数字で記載する 

・複数の記載はしないこと 

  <Mode> M ・サポートする描画モード 

（WhiteBoard,Maker,TouchSelect,FileOnly）を記載す

る。 

・複数記載する場合は連続してカンマで区切って記載

する 

  <SharingCapability> M ・描画能力の詳細を記載 

  <Private> O ・独自拡張とする 

※「M」=必須、「O」=オプション 

 

 <Version> 

発呼機器のプロトコルバージョンを記載する。（A.2.1 節を参照） 

 ■記述方法 

  プロトコルバージョン 

 例：1.0,1.1 

 

 <AgentName> 

発呼機器の機器種別（ベンダ名,機器名（アプリケーション名）,機器バージョン（アプリケーションバージ

ョン））を記載する。（A.2.2 節を参照） 

 ■記述方法 

ベンダ名, 機器名（アプリケーション名）,機器バージョン（アプリケーションバージョン） 
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例：TTC,ApplianceA,1.0 

 <Mode> 

発呼機器がサポートする描画モード（6.5 章を参照）を記載する。描画モードを複数記述する場合は連続し

てカンマで区切って記述する。 

 WhiteBoard（ホワイトボードモード） 

手書きレイヤ（上層）に書いているもののみを共有するモードである。 

 Maker（マーカモード） 

コンテンツレイヤ（下層）にあるコンテンツの上の手書きレイヤに描画を書き加えるモードである。 

 TouchSelect（タッチ選択モード） 

コンテンツレイヤ（下層）にあるコンテンツのボタン等をユーザがタッチ操作するモードである。 

 FileOnly（ファイル共有モード） 

コンテンツのみを共有し、コンテンツレイヤ（下層）にてプレビュを行うモードである。 

 

 <SharingCapability> 

手書きレイヤ及びコンテンツレイヤの描画能力を記載する。 

子要素は、表 B-2 に示すとおりであり SOAP アクション内に XML 文書として記述する。 

なお、SOAP アクション内に記述する XML 文書の電文は、XML 規定 [XML]に従いエスケープする必要が

ある文字があるので注意すること。 

 

表 B-2／TR-1045 手書きレイヤ及びコンテンツレイヤの描画能力（SharingCapability） 

スタンザ/変数 M/O 内容 XML 文書*2 

<SharingCapability> M －  

<Capability  

xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

O － 該当 

 <DrawLayerCapability> O － 該当 

  <Width> C ・手書きレイヤの領域の横幅を半

角数字で記載する 

該当 

  <Height> C ・手書きレイヤの領域の縦幅を半

角数字で記載する 

該当 

  <LoadableFormat> O ・手書き可能な MIME-Type すべ

てをカンマで区切って記載する 

該当 

 <ContentLayerCapability> O － 該当 

  <Web> O ・Web 画面の共有の有無を<Web>

の有無で設定する 

該当 

  <VideoTel> O ・TV 電話画像の共有の有無を

<VideoTel>の有無で設定する 

該当 

  <File> O ・ファイル共有の有無を<File>の

有無で設定する 

該当 

   <PreviewableFormat> C ・ファイル共有前にプレビュ可能

な MIME-Type すべてをカンマで

区切って記載する 

該当 

 <Private> O ・独自拡張とする 該当 
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※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

*2：XML 文書として記述することに該当する箇所であることを示す 

 

 <Capability xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

手書きレイヤ及びコンテンツレイヤの描画能力を XML 文書として記述するための変数である。 

 

 <DrawLayerCapability> 

手書きレイヤの能力を XML 文書として記述するための変数である。 

 

 <Width>,<Height> 

手書きレイヤの領域を半角数字で設定する。 

 

 

 

 

 <LoadableFormat> 

手書き可能なコンテンツファイルの MIME-Type を設定する。複数の MIME-Type を描画可能な場合はすべて

の MIME-Type をカンマで区切って記載する。 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type を設定する。 

 

 <ContentLayerCapability> 

コンテンツレイヤの能力を XML 文書として記述するための変数である。 

 

 <Web> 

コンテンツレイヤにて Web 画面の共有を行うかどうかを<Web>タグの有無で設定する。 

 

 例：Web 画面共有を行う場合   ⇒ <Web />を記載する。 

   Web 画面共有を行わない場合 ⇒ <Web />を記載しない。 

 

 <VideoTel> 

コンテンツレイヤにて TV 電話画像の共有を行うかどうかを<VideoTel>タグの有無で設定する。 

 

 例：TV 電話画像の共有を行う場合   ⇒ <VideoTel />を記載する。 

   TV 電話画像の共有を行わない場合 ⇒ <VideoTel />を記載しない。 

 

 <File> 

コンテンツレイヤにてファイル共有を行うかどうかを<File>タグの有無で設定する。 

 例：ファイル共有を行う場合   ⇒ <File> 

<PreviewableFormat> 

image/*,video/* 

</PreviewableFormat> 

</File> 

Width 

Height 
手書きレイヤ 
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   ファイル共有を行わない場合 ⇒ <File>タグを記載しない。 

 <PreviewableFormat> 

コンテンツレイヤにてファイル共有を行う場合に、プレビュ可能なコンテンツファイルの MIME-Type を設

定する。複数の MIME-Type をプレビュ可能な場合はすべての MIME-Type をカンマで区切って記載する。 

原則 IANA 登録（http://www.iana.org/assignments/media-types/を参照）された MIME-Type を設定する。 

 

 <Private> 

子要素に独自タグを設定できる。 

 

 <Private> 

子要素に独自タグを設定できる。 

 

B.2.5 描画領域応答（ExchangeCapabilityResponse） 

描画領域応答（ExchangeCapability）に対して、着呼機器から発呼機器に対して、プロトコルバージョン及び

機器種別（ベンダ名、機器名（アプリケーション名）、機器バージョン（アプリケーションバージョン））、

サポートする描画モード及び描画能力を通知するために用いる。 

 

表 B-3／TR-1045 描画領域応答（ExchangeCapabilityResponse） 

スタンザ/変数 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・result を記載する 

 id   (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）

を設定する 

<env:Body> M － 

 <ExchangeCapabilityResponse> M － 

  <Version> M  ・プロトコルバージョンを半角英数字で記載する 

  <AgentName> M ・機器種別（ベンダ名,機器名（アプリケーション名）,

機器バージョン（アプリケーションバージョン））

を半角英数字で記載する 

・複数の記載はしないこと 

  <Mode> M ・サポートする描画モード 

（WhiteBoard,Maker,TouchSelect,FileOnly）を記載す

る。 

・複数記載する場合は連続してカンマで区切って記

載する 

  <SharingCapability> M ・描画能力の詳細を記載する 

  <Private> O ・独自拡張とする 

※「M」=必須、「O」=オプション 
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 <Version> 

描画領域応答（ExchangeCapability）の<Version>タグに記載されたプロトコルバージョンの中から利用するバ

ージョン 1 つ選択し記載する。（A.2.1 節を参照） 

対応するバージョンがない場合は、エラーコード：Receiver、サブコード：UnsupportedVersion を返すこと。 

 ■記述方法 

  プロトコルバージョン 

 例：1.0 

 

 <AgentName> 

着呼機器の機器種別（ベンダ名,機器名（アプリケーション名）,機器バージョン（アプリケーションバージ

ョン））を記載する。（A.2.2 節を参照） 

 ■記述方法 

ベンダ名, 機器名（アプリケーション名）,機器バージョン（アプリケーションバージョン） 

例：TTC,ApplianceB,2.0 

 

 <Mode> 

描画領域応答（ExchangeCapability）の<Mode>に記載された描画モードの中から利用する描画モードを 1 つ

選択し記載する。 

対応する描画モードがない場合は、エラーコード：Receiver、サブコード：UnsupportedMode を返すこと。 

 

 <SharingCapability> 

描画領域応答（ExchangeCapability）の<SharingCapability>タグに記載された手書きレイヤ及びコンテンツレ

イヤの描画能力の中から着呼機器がサポートしている描画能力を記載する。（表 B-2 を参照） 

対応する手書きレイヤの描画能力がない場合は、エラーコード： Receiver 、 サブコード：

InvalidDrawLayerCapability を返すこと。また、対応するコンテンツレイヤの描画能力がない場合は、エラー

コード：Receiver、サブコード：InvalidContentLayerCapability を返すこと。 

子要素は、表 B-2 に示す通りであり SOAP アクション内に XML 文書として記述する。 

なお、SOAP アクション内に記述する XML 文書の電文は、XML 規定 [XML]に従いエスケープする必要が

ある文字があるので注意すること。 

 

 <Private> 

子要素に独自タグを設定できる。 
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B.2.6 描画開始要求（SetMode） 

発呼機器は着呼機器に対して、利用する描画モードを通知する。また、発呼機器は着呼機器に対して、手書

きレイヤがある場合は手書きレイヤの詳細情報を通知するために用いる。 

 

表 B-4／TR-1045 描画開始要求（SetMode） 

スタンザ/変数 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・set を記載する 

 id   (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を

設定する 

<env:Body> M － 

 <SetMode> M － 

  <Mode> M ・利用する描画モード 

（WhiteBoard,Maker,TouchSelect,FileOnly）を記載する。 

  <InitialBackGround> M ・手書きレイヤの詳細情報を記載 

・<Mode>タグにて FileOnly を選択した場合は、空タグ

とする 

  <Private> O ・独自拡張とする 

※「M」=必須、「O」=オプション 

 

 <Mode> 

利用する描画モード（6.5 章を参照）を WhiteBoard,Maker,TouchSelect,FileOnly の中から選択するために用い

る。 

 

 <InitialBackGround> 

手書きレイヤの詳細情報を記載する。<Mode>タグにて FileOnly を選択した場合は、空タグとすること。 

子要素は、表 B-5 に示すとおりであり SOAP アクション内に XML 文書として記述する。 

なお、SOAP アクション内に記述する XML 文書の電文は、XML 規定[XML]に従いエスケープする必要があ

る文字があるので注意すること。 
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表 B-5／TR-1045 手書きレイヤの詳細情報（InitialBackGround） 

変数 M/O 内容 XML 文

書*2 

<InitialBackGround> M －  

 <BackGroundInfo 

xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

O － 該当 

  <BackGroundColor> O ・手書きレイヤの背景色を設定す

る 

該当 

  <TransparentColor> O ・手書きレイヤの透明色を設定す

る 

該当 

  <SharedContent> O ファイル情報を設定する 該当 

   <Content>  －  

     <Sid> C ・任意の識別子（Integer 32 bit の

範囲で半角数字）を設定する 

該当 

    <ContentName> C ・ファイル名を設定する 該当 

    <Format> C ・ファイルの MIME-Type を設定

する 

該当 

    <Size> C ・ファイルのサイズをバイト数

（Integer 32 bit の範囲で半角数

字）で設定する 

該当 

  <SharedRegion> O ・表示領域の情報？ 該当 

   <Region>  －  

    <X> C ・表示領域の左上の横位置を設定

する 

該当 

    <Y> C ・表示領域の左上の縦位置を設定

する 

該当 

    <Width> C ・表示領域の横幅を設定する 該当 

    <Height> C ・表示領域の縦幅を設定する 該当 

  <Private> O ・独自拡張とする 該当 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

*2：XML 文書として記述することに該当する箇所であることを示す 

 

 <BackGroundInfo xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

手書きレイヤの詳細情報を XML 文書として記述するための変数である。 

 

 <BackGroundColor> 

手書きレイヤの背景色を設定するために用いる。 

WhiteBoad 時：必須（White 等の色を指定する） 

Maker 時：オプション 

TouchSelect 時：オプション 
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 <TransparentColor> 

手書きレイヤの透明色を設定するために用いる。 

WhiteBoad 時：未記述 

Maker 時：必須（White 等の色を指定する） 

TouchSelect 時：必須（White 等の色を指定する） 

 

 <SharedContent> 

共有するファイル情報を設定するために用いる。 

 

 <SharedRegion> 

表示領域の情報を設定するために用いる。 

共有するファイルの描画位置の指定 

 

 

 

 

 

 <Private> 

子要素に独自タグを設定できる。 

 

 <Private> 

子要素に独自タグを設定できる。 

 

 

B.2.7 描画開始応答（SetModeResponse） 

着呼機器は発呼機器に対して、描画開始要求に応答したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-6／TR-1045 描画開始応答 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・result を記載する 

 id    (<iq>の属性値) M ・ストリーム開始応答の id 属性に記載されていた識別子を

記載する 

<env:Body> M － 

 <SetModeResponse> M ・空タグにする 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <Private> 

子要素に独自タグを設定できる。 

X Y 

Width 

Height 

描画領域 

コンテンツ 

描画しない 
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B.2.8 ストリーム開始要求 

発呼機器は着呼機器に対して、ストリーム開始要求を行うために用いる。 

iq スタンザを用いる。 

 

表 B-7／TR-1045 ストリーム開始要求 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・set を記載する 

 id   (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<open> M － 

 <block-size> M ・一度に送信するデータ転送量を記載する。 

（推奨値：1200byte） 

 <sid> M ・SetMode アクションの InitialBackGround タグにて設定し

た sid の値を記載する。 

※「M」=必須、「O」=オプション 

 

B.2.9 ストリーム開始応答 

着呼機器は発呼機器に対して、ストリーム開始要求に応答したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-8／TR-1045 ストリーム開始要求 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・result を記載する 

 id    (<iq>の属性値) M ・ストリーム開始応答の id 属性に記載されていた識別子を

記載する 

※「M」=必須、「O」=オプション 
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B.2.10 データ転送 

発呼機器は着呼機器に対して、コンテンツデータを Base64 にエンコードして送信するために用いる。 

B.2.8 の<block-size>で指定したサイズ毎にファイルの送信完了まで送信する。 

iq スタンザを用いる。 

 

表 B-9／TR-1045 データ転送 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・set を記載する 

 id   (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<data> M － 

 <seq> M ・データのシーケンス番号 

0 から開始し順次インクリメントし、65535 に達した際は 

0 から再度インクリメントする。 

 <sid> M ・SetMode アクションの InitialBackGround タグにて設定し

た sid の値を記載する。 

※「M」=必須、「O」=オプション 

 

B.2.11 データ転送応答 

着呼機器は発呼機器に対して、コンテンツデータを受信したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-10／TR-1045 データ転送応答 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・result を記載する 

 id    (<iq>の属性値) M ・データ転送の id 属性に記載されていた識別子を記載する 

※「M」=必須、「O」=オプション 
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B.2.12 ストリーム終了要求 

発呼機器は着呼機器に対して、ストリーム終了要求を通知するために用いる。 

iq スタンザを用いる。 

 

表 B-11／TR-1045 ストリーム終了要求 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・set を記載する 

 id   (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<close> M － 

 <sid> M ・SetMode アクションの InitialBackGround タグにて設定し

た sid の値を記載する。 

※「M」=必須、「O」=オプション 

 

B.2.13 ストリーム終了応答 

着呼機器は発呼機器に対して、ストリーム終了要求を受信したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-12／TR-1045 ストリーム終了応答 

スタンザ/属性 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・result を記載する 

 id    (<iq>の属性値) M ・ストリーム終了要求の id 属性に記載されていた識別子を

記載する 

※「M」=必須、「O」=オプション 
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B.2.14 テキスト情報通知 

発呼機器あるいは着呼機器からもう一方の機器へテキスト情報を送信するために用いる。 

message スタンザを用いる。なおこの電文に対する対抗端末からの応答電文は存在しない。 

 

表 B-13／TR-1045 テキスト情報通知 

スタンザ/変数 M/O 内容 

<message> M － 

 type  (<message >の属性値) M ・text を記載する 

 id    (<message >の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<body> M － 

 <text> O ・テキスト情報を記載する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <text> 

テキスト情報を記載するために用いる。 

 

 <Private> 

子要素に独自タグを設定できる。 
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B.2.15 手書きレイヤ情報通知 

発呼機器あるいは着呼機器からもう一方の機器へ手書き情報を送信するために用いる。 

message スタンザを用いる。なおこの電文に対する対抗端末からの応答電文は存在しない。 

送信する図形の詳細な指定情報に関しては C.16 に示す通り XML タグではなく属性値として 

記載する必要があるため注意すること。 

 

表 B-14／TR-1045 手書きレイヤ情報通知 

スタンザ/変数 M/O 内容 

<message> M － 

 type  (<message >の属性値) M ・svg を記載する 

 id    (<message >の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<body> M ・以下の SVG 電文の中から相手機器へ送信したい電文を 1

つ選択し記載する 

 <polyline> O ・フリーハンド機能を実現する 

 <polyline> O ・消しゴム機能を実現する 

 <text> O ・文字機能を実現する 

 <line> O ・直前機能を実現する 

 <rect> O ・四角機能を実現する 

 <ellipse> O ・楕円機能を実現する 

 <circle> O ・円機能を実現する 

 <rect> O ・消去機能を実現する 

 <image> O ・画像イメージ機能を実現する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <polyline>（フリーハンド機能） 

線の色及び太さを指定してフリーハンドで曲線を描画するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-15／TR-1045 フリーハンド機能 

変数 M/O 内容 

<polyline> O － 

 stroke C ・線の色を設定する 

 stroke-width C ・線の幅を設定する 

 points C ・フリーハンド曲線を構成する一連の点を座標で設定する 

 stroke-opacity O ・蛍光ペンのように透過させる場合は「1」を記載する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 
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 <polyline>（消しゴム機能） 

線の色を白に指定してフリーハンドで曲線を描画することによって、消しゴム機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-16／TR-1045 消しゴム機能 

変数 M/O 内容 

<polyline> O － 

 stroke C ・線の色を「white」に設定する 

 stroke-width C ・線の幅を設定する 

 points C ・消しゴム機能として、白いフリーハンド曲線を構成する

一連の点を座標で設定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

 

 

 <text>（文字機能） 

文字の色及び大きさを指定して描画する文字機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-17／TR-1045 文字機能 

変数 M/O 内容 

<text> O － 

 x C ・テキスト開始の X 座標を設定する 

 y C ・テキスト開始の Y 座標を設定する 

 font-size C ・フォントサイズを指定する 

 fill C ・文字色を指定する 

 stroke-opacity O ・蛍光ペンのように透過させる場合は「1」を記載する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 
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 <line>（直線機能） 

線の色及び太さを指定して描画する直線機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

表 B-18／TR-1045 直線機能 

変数 M/O 内容 

<line> O － 

 x1 O ・線の始点の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 y1 O ・線の始点の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 x2 O ・線の終点の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 y2 O ・線の終点の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 stroke C ・線の色を設定する 

 stroke-width C ・線の幅を設定する 

 stroke-opacity O ・線の透明度を指定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

 

 

 

 <rect>（四角形機能） 

線の色及び太さ、内側の塗りつぶしの色を指定して描画する四角形機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

表 B-19／TR-1045 四角形機能 

変数 M/O 内容 

<rect> O － 

 x O ・表示領域の左右端の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 y O ・表示領域の上下端の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 width C ・表示領域の横幅を設定する 

 height C ・表示領域の縦幅を設定する 

 fill C ・図形の外線の内側の色を設定する 

 stroke C ・図形の外線の色を設定する 

 stroke-width C ・図形の外線の幅を設定する 

 stroke-opacity O ・図形の外線の透明度を設定する 

蛍光ペンのように透過させる場合は「1」を記載する 

 fill-opacity O ・図形の外線の内側の色の透明度を設定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 
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 <ellipse>（楕円機能） 

ペンの色及び太さ、内側の塗りつぶしの色を指定して描画する楕円機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-20／TR-1045 楕円機能 

変数 M/O 内容 

<ellipse> O － 

 cx O ・楕円の中心の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 cy O ・楕円の中心の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 rx C ・楕円の X 軸半径の長さを設定する 

 ry C ・楕円の Y 軸半径の長さを設定する 

 fill C ・図形の外線の内側の色を設定する 

 stroke C ・線の色を設定する 

 stroke-width C ・線の幅を設定する 

 stroke-opacity O ・図形の外線の透明度を設定する 

 fill-opacity O ・図形の外線の内側の色の透明度を設定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

 

 

 <circle>（円機能） 

ペンの色及び太さ、内側の塗りつぶしの色を指定して描画する円機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-21／TR-1045 円機能 

変数 M/O 内容 

<circle> O － 

 cx O ・円の中心の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 cy O ・円の中心の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 r C ・円の半径を設定する 

 fill C ・図形の外線の内側の色を設定する 

 stroke C ・線の色を設定する 

 stroke-width C ・線の幅を設定する 

 stroke-opacity O ・図形の外線の透明度を設定する 

 fill-opacity O ・図形の外線の内側の色の透明度を設定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 
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 <rect>（消去機能） 

描画領域を白色で塗りつぶすことによって、消去機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-22／TR-1045 四角形機能 

変数 M/O 内容 

<rect> O － 

 x O ・表示領域の左右端の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 y O ・表示領域の上下端の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 width C ・表示領域の横幅を設定する 

 height C ・表示領域の縦幅を設定する 

 fill C ・図形の外線の内側の色を設定する 

 stroke C ・線の色を「white」を設定する 

 stroke-width C ・線の幅を設定する 

 stroke-opacity O ・図形の外線の透明度を設定する 

 fill-opacity O ・図形の外線の内側の色の透明度を設定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

 

 

 

 <image>（画像イメージ機能） 

画像イメージを描画する画像イメージ機能を実現するために用いる。 

描画の詳細値はタグ内の属性値として記載すること。 

 

表 B-23／TR-1045 四角形機能 

変数 M/O 内容 

<image> O － 

 x O ・表示領域の左右端の X 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 y O ・表示領域の上下端の Y 座標を設定する 

 この座標が設定されていない場合、「0」とみなす 

 width C ・表示領域の横幅を設定する 

 height C ・表示領域の縦幅を設定する 

 xlink:href C ・RFC2397 に則って、URL をテキストエンコードされたバ

イナリで指定する 

※「M」=必須、「O」=オプション、「C」=上位の変数が記載された場合は必須 

 

 <Private> 

子要素に独自タグを設定できる。 

－ 43 － ＴＲ－１０４５ 

 



 

 

B.2.16 画面のタッチ情報送信 

発呼機器は着呼機器に対して、描画モードがタッチ選択モード時に画面のタッチ情報を通知するために用い

る。iq スタンザを用いる。 

 

表 B-24／TR-1045 画面のタッチ情報送信 

スタンザ/変数 M/O 内容 

<iq> M － 

 type   (<iq>の属性値) M ・set を記載する 

 id     (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<env:Body> M － 

 <SendTouchPoint> M ・画面のタッチした位置を通知するために使用する属性 

  <X> M ・画面のタッチした位置として左上からの横位置を設定す

る 

  <Y> M ・画面のタッチした位置として左上からの縦位置を設定す

る 

  <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 <SendTouchPoint> 

画面のタッチした位置を半角数字で設定するために用いる。 

 

 <Private> 

子要素に独自タグを設定できる。 

 

B.2.17 画面のタッチ情報応答 

着呼機器は発呼機器に対して、画面のタッチ情報送信を受信したことを通知するために用いる。 

iq スタンザを用いる。 

表 B-25／TR-1045 画面のタッチ情報応答 

スタンザ/変数 M/O 内容 

<iq> M － 

 result   (<iq>の属性値) M ・result を記載する 

 id      (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<env:Body> M － 

 <SendTouchPointResponse> M － 

  <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <Private> 

子要素に独自タグを設定できる。 

Y X タッチした位置 
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B.2.18 手書きレイヤ表示設定送信 

発呼機器あるいは着呼機器からもう一方の機器へ手書きレイヤの表示を変更する情報を送信するために用

いる。 

iq スタンザを用いる。 

表 B-26／TR-1045 手書きレイヤ表示設定送信 

スタンザ/変数 M/O 内容 

<iq> M － 

 type    (<iq>の属性値) M ・set を記載する 

 id    (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<env:Body> M － 

 <SetDrawLayer> M ・手書きレイヤの表示を変更する情報を通知するために使

用する属性 

  <State> M ・手書きレイヤの表示を変更する情報を設定する 

  <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 <State> 

手書きレイヤの表示を変更する情報を設定する。 

手書きレイヤを表示する場合は「Show」を設定し、非表示にする場合には「Hide」を設定する。 

 

 <Private> 

子要素に独自タグを設定できる。 

 

B.2.19 ファイル送信要求（ShareContent） 

発呼機器は着呼機器に対して、ファイル送信要求を行うために用いる。ファイル送信要求を送信後、発呼機

器及び着呼機器は同様のファイルを表示すること。 

iq スタンザを用いる。 

表 B-27／TR-1045 ファイル送信要求（ShareContent） 

スタンザ/変数 M/O 内容 

<iq> M － 

 type    (<iq>の属性値) M ・set を記載する 

 id      (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定

する 

<env:Body> M － 

 <ShareContent> M － 

  <Type> M ・共有するコンテンツの種別を記載する 

（File,Web,VideoTel）の中からいずれか 1 つを記載する。 

  <SharedContent> M ・コンテンツの詳細情報を記載する 

  <SharedRegion> O ・コンテンツの表示領域を記載する 

  <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 
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 <Type> 

共有するコンテンツの種別を（File,Web,VideoTel）の中からいずれか 1 つを記載する。 

 File: 電子ファイルを共有する場合に記載する。 

 Web: Web ページを共有する場合に記載する。 

 VideoTel:TV 電話映像を共有する場合に記載する。 

 

 <SharedContent > 

コンテンツの詳細情報を記載する。子要素は、表 B-28 に示すとおりであり SOAP アクション内に XML 文書

として記述する。なお、XML 文章はエスケープを行う必要があるため注意すること。 

表 B-28／TR-1045 コンテンツの詳細情報 

変数 M/O 内容 XML

文書*2 

<SharedContent> M －  

 <Content xmlns= 

‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

M － 該当 

  <Sid> O ・<Type>タグで File を選択時必須 

・任意の識別子（Integer 32 bit の

範囲で半角数字）を設定する 

該当 

  <ContentName> O ・<Type>タグで File を選択時必須 

・ファイル名を設定する 

該当 

  <Format> O ・<Type>タグで File を選択時必須 

・ファイルの MIME-Type を設定

する 

該当 

  <Size> O ・<Type>タグで File を選択時必須 

・ファイルのサイズをバイト数

（Integer 32 bit の範囲で半角数

字）で設定する 

該当 

  <URL> O ・<Type>タグで Web を選択時必

須 

・共有する Web ページの URL を

記載する 

該当 

  <Display> O ・<Type>タグで VideoTel を選択時

必須 

・共有する TV 電話の映像を記載

する 

ActionCaller：要求側画像 

ActionCallee：被要求側画像 

該当 

  <Private> O ・独自拡張用とする 該当 

※「M」=必須、「O」=オプション 

 <SharedRegion> 

コンテンツの表示領域を記載する。子要素は、表 B-29 に示すとおりであり SOAP アクション内に XML 文書

として記述する。なお、XML 文章はエスケープを行う必要があるため注意すること。 
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表 B-29／TR-1045 コンテンツの詳細情報 

変数 M/O 内容 XML 文書

*2 

<SharedRegion> O －  

 <Region 

xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

O － 該当 

  <X> O ・表示領域の情報？ 該当 

  <Y> O ・表示領域の左上の横位置を

設定する 

該当 

  <Width> O ・表示領域の左上の縦位置を

設定する 

該当 

  <Height> O ・表示領域の横幅を設定する 該当 

  <Private> O ・独自拡張用とする 該当 

※「M」=必須、「O」=オプション 

 

 <Private> 

子要素に独自タグを設定できる。 

 

B.2.20 ファイル送信応答（ShareContentResponse） 

着呼機器は発呼機器に対して、ファイル送信要求を受信したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-30／TR-1045 ページ指定情報通知 

スタンザ/変数 M/O 内容 

<iq> M － 

 type    (<iq>の属性値) M ・result を記載する 

 id      (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定

する 

<env:Body> M － 

 <ShareConentResponse> M ・空タグにする 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <Private> 

子要素に独自タグを設定できる。 
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B.2.21 コンテンツ共有のキャンセル情報通知（CancelShareContent） 

送信中のコンテンツ共有及び送信をキャンセルする情報を通知するために用いる。 

iq スタンザを用いる。 

 

表 B-31／TR-1045 コンテンツのキャンセル情報通知 

スタンザ/変数 M/O 内容 

<iq> M － 

 type    (<iq>の属性値) M ・set を記載する 

 id      (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

<env:Body> M － 

 <CancelShareContent> M ・コンテンツのキャンセル情報を通知するために使用する

属性 

  <sid> M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定す

る 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <sid> 

特定のコンテンツの送信をキャンセルする時に、コンテンツ送信時の識別子である SID を指定する。複数の

送信をキャンセルする場合には、コンテンツ共有のキャンセル情報通知を複数回送信する。また、識別子を

指定しない場合には、送信中の全てのコンテンツ共有をキャンセルする。 

 

B.2.22 コンテンツ共有のキャンセル情報応答（CancelShareContentResponse） 

コンテンツ共有のキャンセル情報通知を受信し、送信中のコンテンツ共有及び送信をキャンセルしたことを

通知するために用いる。 

iq スタンザを用いる。 

 

表 B-32／TR-1045 コンテンツのキャンセル情報応答 

スタンザ/変数 M/O 内容 

<iq> M － 

 type    (<iq>の属性値) M ・result を記載する 

 id      (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定

する 

<env:Body> M － 

 <CancelShareContentResponse> M ・コンテンツのキャンセル情報を通知するために使用する

属性 

  <sid> M ・キャンセルされた識別子（Integer 32 bit の範囲で半角数

字）をカンマで区切って記載する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 
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 <sid> 

特定のコンテンツの送信をキャンセルした時に、コンテンツ送信時の識別子である sid を指定する。複数の

送信をキャンセルした場合には、コンテンツ共有のキャンセル情報通応答を複数回送信する。また、送信中

の全てのコンテンツ共有をキャンセルした場合には、識別子を指定しないこと。 

 

 <Private> 

子要素に独自タグを設定できる。 
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B.2.23 ページ指定情報通知 

ページの概念が存在するコンテンツ共有時に、ページ移動を行う情報を通知するために用いる。 

iq スタンザを用いる。 

 

表 B-33／TR-1045 ページ指定情報通知 

スタンザ/変数 M/O 内容 

<iq> M － 

 type   (<iq>の属性値) M ・set を記載する 

 id     (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定

する 

<env:Body> M － 

 <GotoNextPage> O ・空タグにする 

・1 ページ先へ移動する 

 <GotoPreviousPage> O ・空タグにする 

・1 ページ前へ移動する 

 <GotoFirstPage> O ・空タグにする 

・最初のページへ移動する 

 <GotoLastPage> O ・空タグにする 

・最終ベージへ移動する 

 <Private> O ・独自拡張用とする 
※「M」=必須、「O」=オプション 

 

 <GotoNextPage>,<GotoPreviousPage>,<GotoFirstPage>,<GotoLastPage> 
ページ移動を行う際に、以下のいずれかの変数を用いる。 

 
<GotoNextPage> ：1 ページ先へ移動する 
<GotoPreviousPage> ：1 ページ前へ移動する 
<GotoFirstPage> ：最初のページへ移動する 
<GotoLastPage> ：最終ページへ移動する 
 

 <Private> 

子要素に独自タグを設定できる。 
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B.2.24 ページ指定情報応答 

ページ指定情報通知を受信し、ページ移動したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-34／TR-1045 ページ指定情報応答 

スタンザ/変数 M/O 内容 

<iq> M － 

 type  (<iq>の属性値) M ・result を記載する 

 id    (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定

する 

<env:Body> M － 

 <GotoNextPageResponse> O ・空タグにする 

・1 ページ先へ移動する 

 <GotoPreviousPageResponse> O ・空タグにする 

・1 ページ前へ移動する 

 <GotoFirstPageResponse> O ・空タグにする 

・最初のページへ移動する 

 <GotoLastPageResponse> O ・空タグにする 

・最終ベージへ移動する 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <GotoNextPageResponse>,<GotoPreviousPageResponse>,<GotoFirstPageResponse>,<GotoLastPageResponse> 

ページ指定情報通知の<env:Body>内の変数に応じた変数を用いる。 

 
<GotoNextPage> ⇒ <GotoNextPageResponse> 
<GotoPreviousPage> ⇒ <GotoPreviousPageResponse> 
<GotoFirstPage> ⇒ <GotoFirstPageResponse> 

<GotoLastPage> ⇒ GotoLastPageResponse> 

 

 <Private> 

子要素に独自タグを設定できる。 

－ 51 － ＴＲ－１０４５ 

 



 

 

B.2.25 ファイルの単独送信要求（SendContent） 

発呼機器は発呼機器に対して、ファイルの単独送信要求を送信ために用いる。ファイル送信時にプレビュは

行わない。 

iq スタンザを用いる。 

 

表 B-35／TR-1045 ファイルの単独送信要求（SendContent） 

スタンザ/変数 M/O 内容 XML 文

書*2 

<iq> M －  

 type   (<iq>の属性値) M ・set を記載する  

 id     (<iq>の属性値) M ・任意の識別子（Integer 32 

bit の範囲で半角数字）を

設定する 

 

<env:Body> M －  

 <SendContent> M －  

  <SelectedContent> M －  

   <Content             

xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 

M － 該当 

    <sid> M ・<Type>タグで File を選

択時必須 

・任意の識別子（Integer 32 

bit の範囲で半角数字）を

設定する 

該当 

    <ContentName> M ・<Type>タグで File を選

択時必須 

・ファイル名を設定する 

該当 

    <Format> M ・<Type>タグで File を選

択時必須 

・ファイルの 

MIME-Type を設定する 

該当 

    <Size> M ・<Type>タグで File を選

択時必須 

・ファイルのサイズをバ

イト数（Integer 32 bit の範

囲で半角数字）で設定す

る 

該当 

 <Private> O ・独自拡張用とする  

※「M」=必須、「O」=オプション 

 

 <Private> 

子要素に独自タグを設定できる。 
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B.2.26 ファイルの単独送信応答（SendContentResponse） 

着呼機器は発呼機器に対して、ファイルの単独送信要求を受信したことを通知するために用いる。 

iq スタンザを用いる。 

 

表 B-36／TR-1045 ファイルの単独送信応答（SendContentResponse） 

スタンザ/変数 M/O 内容 

<iq> M － 

 type   (<iq>の属性値) M ・result を記載する 

 id     (<iq>の属性値) M ・任意の識別子（Integer 32 bit の範囲で半角数字）を設定

する 

<env:Body> M － 

 <SendContentResponse > M ・空タグにする 

 <Private> O ・独自拡張用とする 

※「M」=必須、「O」=オプション 

 

 <Private> 

子要素に独自タグを設定できる。 

 

B.2.27 接続終了要求 

ホワイトボード共有の終了時に、接続終了要求を行う機器からストリームを終了を行うために用いる。 

 

<presence type='unavailable' /> 

</stream:stream> 

図 B-4／TR-1045 接続終了要求 

 

B.2.28 接続終了応答 

接続終了要求を受けた端末側で、ストリーム終了を通知するために用いる． 

 

</stream:stream> 

図 B-5／TR-1045 接続終了応答 
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B.3 異常系の動作規定 
 
 

異常系の動作に対する対策案を表 B-37 に示す。なお、この動作規定は参考であり実用にあたっては更なる

詳細規定を行っていく必要がある。 

表 B-37 異常系の動作規定 

項番 状況 対応策 

1 各フェーズで規定以外のメッセージを受

信した場合 

規定フェーズ以外のメッセージは無視し処理を継

続する 

2 コンテンツ送受信中に TCP セッションが

切断された場合． 

（予期せぬ FIN や RST） 

 

TCP の再接続は行わず、シーケンス上は終了とし、

アウトチャネルのセッションも切断すること．（再

度、ホワイトボード共有する場合は合うとチャネル

の呼接続から開始とする．） 

3 <iq>スタンザ内のメッセージが不正であ

る場合 

type を’error’に設定して応答 

4 SOAP アクションが処理できない場合 SOAP エラーを設定して応答する。 

独自規定のエラーコードに関しては B.4 章参照 

 

B.4 SOAP エラー表記の規定 

SOAP を用いたメッセージの不正の発生時には図B-6に示すようにXMPP の iqスタンザでのエラー表記に 

加えて、SOAP でのエラーメッセージの表記を利用する。 

 
<iq type=‘error' id=‘4'> 
<env:Envelope   
xmlns =“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:eise=“http://www.ttc.or.jp/mmsys/cs/error/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
 <env:Fault> 
        <env:Code> 
          <env:Value>env:Sender</env:Value> 
          <env:Subcode> 
            <env:Value>eise:サブコード</env:Value> 
          </env:Subcode> 
        </env:Code> 
        <env:Reason> 
          <env:Text xml:lang=‘en-JP‘>端末実装のエラーメッセージ</env:Text> 
        </env:Reason> 
      </env:Fault> 
    </env:Body> 
</env:Envelope>  
 <error code='500' type='modify'> 
    <undefined-condition xmlns='urn:ietf:params:xml:ns:xmpp-stanzas'/> 
    <Sender xmlns='http://jabber.org/protocol/soap#fault'/> 
  </error> 
 </iq> 

図 B-5／TR-1045 エラー表記例 

 

なお、SOAP アクションが正常動作しない場合の本仕様における独自コードを表 B-38 に示す。 
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表 B-38 SOAP エラー表記（全てのアクション共通） 

項

番 

エラー 

コード 

サブコード 詳細 [対応アクション] 

1 Sender/Receiver/ 

DataEncodingUnknown/ 

VersionMismatch 

UnexpectedError 想定外のエラー  

[全て] 

2 VersionMismatch (なし) ネームスペース、ローカルネームが解釈不能 

[全て] 

3 Sender InvalidParameter 別のエラーで表記負荷のパラメータ不正 

[全て] 

4 Receiver UnsupportedAction 未対応アクション（独自拡張など）[全て] 

5 Receiver ActionConflict アクションのクロス（双方同時要求時） 

[全て] 

6 Sender InvalidDrawLayerCapability 手書きレイヤの能力表記が不正 

[ExchangeCapability] 

7 Sender InvalidContentLayerCapablity コンテンツレイヤの能力表記が不正 

[ExchangeCapability] 

8 Sender InvalidRegion 貼り付け位置の異常 

[SetMode,ShareContent] 

9 Sender InvalidTransparentColor 透過色の設定色が不正 [SetMode] 

10 Sender InvalidBackgroundColor 背景色の設定色が不正 [SetMode] 

11 Sender InvalidTouchPoint タッチ情報の不正 [SetTouchPoint] 

12 Sender NoSession 送信キャンセルするファイルが存在しない 

[CancelShareContent] 

13 Sender NoSuchSid 指定された sid が存在しない 

[CancelShareContent] 

14 Sender NoNextPage 次のページが存在しない 

[GotoNextPage,GotoLastPage] 

15 Sender NoPreviousPage 前のページが存在しない 

[GotoPreviousPage,GotoFirstPage] 

16 Receiver UnsupportedVersion ホワイトボード共有のバージョン不正 

[ExchangeCapability]] 

17 Receiver UnsupportedMode モード未対応  

[ExchangeCapability,SetMode,SendContent] 

18 Receiver UnsupportedFileFormat ファイルタイプ未対応 

[SetMode,ShareContent] 

19 Receiver FileSizeOver ファイルサイズ超過 

[SetMode,ShareContent,SendContent] 

20 Receiver CanceledByUser ユーザによるキャンセル 

[SetMode,ShareContent,SendContent] 

21 Receiver UnsupportedContentType コンテンツのタイプ非対応 

[ShareContent] 
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付属資料C 各メッセージ例 

C.1 F1,F2 接続確立要求 

<?xml version='1.0' encoding='UTF-8'?> 

<stream:stream xmlns=’ttc:EasyInfoSharing’ 

             xmlns:stream=‘http://www.ttc.or.jp/mmsys/cs/stream/’> 

（図 B-1/図 B-2 と同様） 

 

C.2 F3,F4 接続確立要求 

<presence type='available' /> 

（図 B-3 と同様） 
 

C.3 F5 描画領域要求 
<iq type='set' id='1'> 
<env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“> 
<env:Body> 
<ExchangeCapability> 
 <Version>0.8,0.7,0.6</Version> 
 <AgentName> 
  ACorp,ApplianceB,VersionC 
 </AgentName> 
 <Mode>WhiteBoard,Marker</Mode> 
 <SharingCapability> 
     <?xml version='1.0' encoding='UTF-8‘ ?> 
      <Capability  
              xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 
       <DrawLayerCapability > 
       <Width>800</Width> 
          <Height>600</Height>      
    <LoadableFormat> image/*</LoadableFormat> 
   </DrawLayerCapability> 
     <ContentLayerCapability> 
            <Web /> 
            <File> 
              <PreviewableFormat> 
                  image/*,video/* 
              </PreviewableFormat> 
            </File> 
            <VideoTel/> 
        </ContntentLayerCapabiilty> 

</Capability> 
 </SharingCapability>     
</ExchangeCapability> 
</env:Body> 
</env:Envelope>  
</iq> 

 

※SharingCapability 内はエスケープ処理が必要 

 

C.4 F6 描画領域応答 
<iq type=‘result' id=‘1'> 
<env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
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<ExchangeCapabilityResoponse> 
 <Version>0.8</Version> 
 <AgentName> 
     VendorD,TerminalE,1.01F 
  </AgentName> 
  <Mode>Marker</Mode> 
 <SharingCapability> 
     <?xml version='1.0' encoding='UTF-8‘ ?> 
      <Capability     
           xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 
       <DrawLayerCapability > 
        <Width>600</Width> 
           <Height>480</Height> 
       <LoadableFormat/> 
   </DrawLayerCapability> 
     <ContentLayerCapability> 
            <File> 
                 <PreviewableFormat> 
                           image/* 
                 </PreviewableFormat> 
            </File> 
    </ContntentLayerCapabiilty> 

</Capability> 
 </SharingCapability>     
</ExchangeCapbilityResponse> 
</env:Body> 
</env:Envelope>  
</iq> 
 

※SharingCapability 内はエスケープ処理が必要 
 
  

C.5 F7 描画開始要求 
 
<iq type='set' id='2'> 
 <env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
 <SetMode>  
  <Mode>Marker</Mode> 
 <InitialBackGround> 
          <?xml version='1.0' encoding='UTF-8‘ ?>  
      <BackGroundInfo 
                xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 
                <TransparentColor>Navy</TransparentColor> 
      </BackGroundInfo>   
   <InitialBackGround>    
</SetMode> 
</env:Body> 
</env:Envelope>  
</iq> 
 

※InitialBackGround 内はエスケープ処理が必要 
 

C.6 F8 描画開始応答 
<iq type=‘result' id=‘2'> 
 <env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
 <SetModeResponse /> 
</env:Body> 
</env:Envelope>  
</iq> 
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C.7 F9 コンテンツの共有要求 
<iq type='set' id='3'> 
<env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
 <ShareContent> 
  <Type>File</Type> 
     <SharedContent> 
   <?xml version='1.0' encoding='UTF-8‘ ?> 
      <Content 
               xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 
            <sid>ch3d9s71</sid> 
             <ContentName>test.jpg</ContentName> 
             <Format>image/jpg</Format> 
            <Size>123514</Size> 
         </Content> 
     </SharedContent> 
  <SharedRegion> 
   <?xml version='1.0' encoding='UTF-8‘ ?>  
        <Region 
               xmlns=‘http://www.ttc.or.jp/mmsys/cs/parameter/’> 
              <X>0</X> 
               <Y>0</Y> 
               <Width>300</Width> 
               <Height>200</Height> 
        </Region> 
     </SharedRegion> 
   </ShareContent>  
</env:Body> 
</env:Envelope>  
</iq> 

※SharedContent、SharedRegion 内はエスケープ処理が必要 
 
 

C.8 F10 コンテンツの共有応答 
<iq type=‘result' id=‘3'> 
<env:Envelope   
xmlns=“http://www.ttc.or.jp/mmsys/cs/soap/” 
xmlns:env=“http://www.w3.org/2003/05/soap-envelope“ > 
<env:Body> 
 <ShareContentResponse /> 
</env:Body> 
</env:Envelope> 
 
C.9 F11 ストリーム開始要求 
<iq type=‘set' id=‘4'> 
  <open block-size=‘1200’ sid='ch3d9s71'/> 
 </iq> 
 
C.10 F12 ストリーム開始応答 
<iq type=‘result' id=‘4'> 
 
C.11 F13 データ転送通知<data> 
<iq type='set' id=‘5’'> 
 <data ' seq='0' sid='ch3d9s71'> 
    qANQR1DBwU4DX7jmYZnncmUQB/9KuKBddzQH+tZ1ZywKK0yHKnq57kWq+RFtQdCJ 
    WpdWpR0uQsuJe7+vh3NWn59/gTc5MDlX8dS9p0ovStmNcyLhxVgmqS8ZKhsblVeu 
    IpQ0JgavABqibJolc3BKrVtVV1igKiX/N7Pi8RtY1K18toaMDhdEfhBRzO/XB0+P  
 </data> 
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</iq> 
 
C.12 F14 データ転送応答<data> 
<iq type=‘result' id=‘5'> 
 
※データ転送が終わるまで F13,F14 を繰り返す 
 
C.13 F15 ストリーム終了要求 
<iq type='set' id='1718'>  
  <close sid= 'ch3d9s71'/>  
</iq> 
 
C.14 F16 ストリーム終了応答 
<iq type=‘result' id=‘1718'> 
 
C.15 F17 ,F18 テキスト情報通知 
<message type=‘text’ id='1719'> 

<body> 
 <text>共有メッセージ</text> 

 </body> 
</message> 
 
C.16 F19,F20 手書きレイヤ情報通知 
<message type=‘text’ id='1719'> 
<body> 
 <polyline fill="none" stroke=“white" stroke-width="10"  
            points="200,1300 220,1310 240,1300 260,1320 280,1300 300,1330 320,1300 340,1340 360,1300" /> 
 </body> 
</message> 
 
 
C.17 F21 接続終了要求 
<presence type='unavailable' /> 
</stream:stream> 

(図 B-4 と同様) 
 
C.18 F21 接続終了要求 
</stream:stream> 
 
(図 B-4 と同様) 
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